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Safety Instructions
Before starting the experiment, students must be familiar with the laboratory regulations. A
printed version of the regulations can be found next to the laboratory entrance. In particular,
the following sources of hazard will be encountered during the course:

Nitrogen dioxide cuvette

For parts of the experiment a nitrogen dioxide (NO2) cuvette with an NO2 volume mixing
ratio between 0.5 and 1.0% will be used. NO2 is harmful by inhalation. In case of nausea or
respiratory tract irritation call a poison control center or doctor. In case of release of gas from
the cuvette immediately leave the room and open windows if possible. Inform your experiment
supervisor. Storage may only be carried out in well-ventilated areas. The cuvette must therefore
be returned to an appropriate room after completion of the experiment.

Ethanol solution

Occasionally ethanol solution has to be applied to clean the optics in the telescope. If you
need to clean any optical components please ask your tutor. The ethanol is stored safely in
another room. Inhalation, eye and skin contact should be avoided. When working with it, wear
protective gloves and eye protection. Keep the container away from any source of ignition and
keep it tightly closed, if not in use. In case of contact with eyes, flush them with water for a
few minutes. After swallowing drink plenty of water, then seek medical advice immediately.

Ultra violet (UV) radiation

In this experiment, a UV light source is used. UV radiation irritates and damages the eyes.
Skin irritation and even severe burns can occur in case of continuous UV exposure. When
working with the lightsource wear appropriate protective goggles. Do not look directly into the
light. Avoid direct exposure of the skin. If possible, screen the optical setup. Do not use the
light source longer than necessary.

Details on the listed hazards can be found in the information sheets attached to the labo-
ratory regulations. By signing the ’Safety Briefing - Signature List’, you confirm, that you have
read and understood these instructions.
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Overview

Differential Optical Absorption Spectroscopy (DOAS) is a widely used technique for the detec-
tion of atmospheric trace gases. It is based on the wavelength dependent absorption of light by
atmospheric constituents. Various trace gases can be identified simultaneously by their spectral
signatures which act as an individual ’fingerprint’. The DOAS technique has been implemented
on several platforms: from ground, on aircrafts, balloons and satellites, and by using either
artificial light sources, scattered sunlight, or direct sun- or moonlight.
Ground-based DOAS observations of scattered sunlight are very suitable both for long term
measurements of atmospheric constituents and for measurements in the field using small portable
instruments. The latter can be used, for example, to study emissions from volcanic plumes or
the emission of reactive trace gases from remote salt lakes. Since those instruments are easy to
maintain, they are ideally suited for the operation in remote regions with restricted technical
infrastructure.
This experiment offers the opportunity to gain insight into spectroscopic remote sensing tech-
niques, which are widely used to study the composition of the Earth’s atmosphere. The DOAS
method has been developed by U. Platt and D. Perner at the Institute of Environmental Physics
of Heidelberg University. A relatively new application of this measurement technique is Multi-
Axis DOAS (MAX-DOAS), which has an enhanced sensitivity for trace gases near the surface
and allows to gain information on their vertical distribution.
The topics covered by this experiment are:

• To gain insight in the chemistry of the troposphere and stratosphere, in particular re-
garding ozone (O3) and nitrogen dioxide (NO2)

• To become familiar with spectroscopy and spectroscopic analysis techniques

• To gain insight into radiative transfer in the Earth’s atmosphere

• To learn how to determine a trace gas concentration with DOAS

Instrumentation:

• Passive DOAS instrument with spectrograph/detector unit

• Quartz fiber

• Temperature regulator

• Halogen lamp

• Mercury vapor lamp

• Computer with measurement and analysis software

• Glass cell filled with NO2
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Study Guide

Before starting the experiment, please take the time to review these materials. While you do
not need to know the exact step-by-step procedure of the experiment, you should be able to
answer the following questions:

• How are O3 and NO2 distributed in the atmosphere? What are typical concentrations of
these species? How do the concentrations vary with the time of day?

• What is the importance of O3 in the stratosphere? What is the ozone hole? How is it
formed?

• What is the importance of O3 and NO2 in the troposphere?

• What is the Beer-Lambert law of absorption? What does it describe?

• What does the word differential mean in Differential Optical Absorption Spectroscopy?
Why is absolute absorption spectroscopy difficult to apply in the atmosphere?

• What components contribute to a measured spectrum?

• What equipment is necessary to record an atmospheric spectrum and why?

• What is a slant column density? What is a differential slant column density? What is a
vertical column density?

• What is a Langley Plot? What is it used for?

• What knowledge is required in order to calculate trace gas concentrations from differential
slant column densities?

• What is Multi-Axis DOAS? How can information about the vertical profile of a trace gas
species be obtained with this technique?
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Chapter 1

Background Information

1.1 The Atmosphere
Earth’s atmosphere can be divided into layers. The most common classification is linked to the
temperature. According to this scheme, the atmosphere is divided into the troposphere, the
stratosphere, the mesosphere, the thermosphere and the exosphere. The regions dividing two
layers are called ’pause’, as in tropopause.
In the troposphere, the energy flow is dominated by incoming solar radiation heating up the
surface (Figure 1.1). Sensible1 and latent2 heat are then transported from the ground up
into the troposphere, and thermal energy is converted into potential energy. The updraft of
an airparcel from the ground can be approximated by adiabatic cooling, which explains the
temperature decline of 6Kkm−1 – 10Kkm−1. This transport of latent heat drives the weather
in the troposphere and explains its turbulent behaviour. On the other hand, the energy balance
in the stratosphere is dominated by radiative heating due to absorption of incoming radiation
by trace gases, for example ozone (O3). This leads to an increase of temperature with altitude
and thus a stratification of the airmasses, hence the term ’stratosphere’.

1.2 Measurements and Dimensions
The concentration of a trace gas is the abundance of molecules in a volumetric unit. The abun-
dance may be measured in number of molecules, where a commonly used unit is molecules cm−3.
Another possibility is a mass concentration, for example in µgm−3.
The mixing ratio is the abundance of a trace gas relative to air. Commonly used units are ppm,
ppb, and ppt. Sometimes, the quantity is related to the volume ratio, where the units ppmv,
ppbv, and pptv may be used.
For DOAS measurements, the column density plays an important role. This is the concen-
tration of a species integrated along a light path and is typically measured in molecules cm−2.
Depending on the light path, this is called slant column density (SCD), or vertical column
density (VCD). For O3, the Dobson Unit3 (DU) has become popular. 100DU correspond to an
O3 VCD of 1mm at 0 ◦C and 1013.25 hPa. Typical O3 VCDs in the atmosphere are 300DU –
400DU. Therefore, the total O3 in the atmosphere corresponds to a layer with 3mm – 4mm
thickness when brought to normal conditions.

1Thermal energy that can be measured with a thermometer.
2Energy originating from evaporation on the ground or in the ocean.
31DU = 2.6× 1016 molecules cm−2
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Figure 1.1: Global annual mean energy budget. ([30])

1.3 Composition of Air
The main constituents of air are oxygen (O2), nitrogen (N2), and argon (Ar) (see Table 1.1).
Water vapor (H2O) can have concentrations of 0.02% – 2.5% in the troposphere. In the
stratosphere, the mixing ratio of water vapor is only about 3 ppm – 4 ppm. All other gases
together make up only 0.04% and are therefore called trace gases. Regarding the stable main
constituents, the atmosphere is well-mixed and the number concentrations are basically pro-
portional to the atmospheric pressure profile. In first approximation, atmospheric pressure
decreases exponentially with altitude, approximately with a surface pressure of 1013 hPa and a
scale height of 8 km. In contrast to the main constituents, trace gas concentrations are signifi-
cantly affected by complex production and destruction cycles and may therefore vary strongly
within space and time.

O4

The O4 molecule is the dimer of the oxygen molecule O2. It can be formed when two oxygen
molecules collide. Therefore, its concentration is proportional to the square of the oxygen
concentration in the atmosphere. For this reason, its column is given in molecules2 cm−5. Its
vertical profile is an exponential decrease with altitude with a scale height of approximately
4 km. Since the vertical profile of O4 concentration is well known, the measured column densities
can be used to gain insight into photon paths in the atmosphere, i.e. light path enhancement
due to aerosols and clouds [33].
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Figure 1.2: Atmospheric temperature profile and layering.

Table 1.1: Chemical makeup of the atmosphere. (https://www.noaa.gov/jetstream/
atmosphere)

Volume Fraction Symbol Gas
78.084% N2 Nitrogen
20.947% O2 Oxygen
0.934% Ar Argon
up to 4% H2O Water vapor
0.035% CO2 Carbon Dioxide
18.182 ppm Ne Neon
1.70 ppm CH4 Methane
1.14 ppm Kr Krypton
0.53 ppm H2 Hydrogen
0.31 ppm N2O Nitrous Oxide
0.10 ppm CO Carbon Monoxide
0.07 ppm O3 Ozone
≈ 4 ppb Chloroflourocarbons (CFCs)
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Chapter 2

Atmospheric Chemistry I:
Stratospheric Ozone

2.1 The Importance of Ozone in the Stratosphere
The ozone molecule (O3) is composed of three oxygen atoms. In its gas phase, it is light blue.
At −111.9 ◦C, it condensates to an explosive, dark blue, magnetic liquid. At −192.5 ◦C, it
crystalizes to a dark violet mass. The dissociation at room temperature is slow, while it occurs
explosively if heated.
The average lifetime of an O3 molecule at an altitude of 25 km is about 1 h. This lifetime
is determined by its photolysis frequency. However, the O3 concentration of a given airmass
changes slowly with time, as most oxygen atoms originating from ozone photolysis quickly react
back to O3 (see Section 2.2). Therefore, it usually takes months or years to significantly change
the O3 concentration in a given airmass. This stands in contrast to the quick reduction seen in
the ozone hole formation discussed in Section 2.2.4.
O3 is a highly efficient absorber of UV radiation. The largest absorption of photons by O3
occurs between 240 nm – 310 nm. Even though it is present only in small concentrations, it
blocks 95% – 99% of the harmful UV radiation (λ < 320 nm) at an altitude of 20 km – 50 km,
as Figure 2.1 shows. Therefore, the ozone layer is of great importance for life on Earth.

2.1.1 Vertical Profile of Ozone Concentration
About 90% of the total O3 column is located in the stratosphere, the rest in the troposphere. In
mid latitudes, the O3 concentration at the ground is about 1×1012 molecules cm−3, while typical
concentrations in the stratosphere are 1 × 1013 molecules cm−3 – 2 × 1013 molecules cm−3 (see
Figure 2.2, left panel). The vertical profile of O3 is determined by the number of UV photons
and the decreasing number of O2 molecules in the upper atmosphere. At high altitudes, the air
is so thin that the UV photons barely ever hit O2 molecules and no atomic oxygen is formed.
As the air density increases at lower altitudes, the probability for oxygen photolysis increases,
which causes more O3 to be formed. The lower end of the ozone layer is reached when no more
UV photons necessary for the formation of O3 are available, as they have all been absorbed in
higher layers.

2.1.2 The Effects of Harmful UV Radiation
The energy of shortwave UV radiation with wavelengths below 320 nm is enough to destroy
molecules, including proteins and amino acids, which are the main constituents of organic
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Figure 2.1: Spectrum of incident solar radiation at the top of the atmosphere and at sea level.

Figure 2.2: Left: O3 concentration vertical profile. Right: The enhancement of harmful UV
radiation is exponential with decreasing O3 columns, as described by the Beer-Lambert law of
absorption. This plot shows data measured in Antarctica between February 1991 and December
1992.

matter. Enhanced UV radiation directly increases the risk of skin cancer and biological mu-
tation, and has even been shown to directly influence marine biology and agriculture (see e.g.
[12, 28, 29, 35]). A decreasing O3 column in the stratosphere enables more UV radiation to
reach Earth’s surface. This relationship is not linear, as shown in Figure 2.2, right panel.

2.2 Photochemistry of Ozone in the Stratosphere

2.2.1 Chapman Cycle
In 1930, Sydney Chapman [3] published the first simple theory about O3 in the stratosphere.
He postulated O3 to be the result of a chemical equilibrium of 4 photochemical reactions. At
altitudes from 20 km – 25 km, atomic oxygen is formed during the photolysis of O2 by shortwave
UV radiation (λ < 242 nm).

O2 + hν −−→ 2O (2.1)
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O3 is then formed by the recombination of the atomic oxygen with molecular oxygen.

O2 +O+M −−→ O3 +M (2.2)

M is a chemically neutral molecule (e.g. N2 or O2) needed for conservation of momentum. To
reach an equilibrium O3 concentration, ozone destruction reactions are also necessary. Chapman
held the photolytic dissociation by photons with a wavelength of λ < 1100 nm of O3 responsible.

O3 + hν −−→ O2 +O(3P) (2.3)

The formed oxygen atoms then either react according to Equation 2.2 and form O3 again, or
they destroy an additional O3 molecule.

O3 +O −−→ 2O2 (2.4)

These four reactions comprise the Chapman cycle. The mechanism postulated by Chapman
was correct, but incomplete. The measured O3 columns were always lower than his prediction,
usually by about 40%. Additionally, the predicted altitude of the maximum O3 concentration
was incorrect.

2.2.2 Catalytic Ozone Destruction
Today, we know that catalytic reactions play an important role in the destruction of O3. These
reactions are enabled by a catalist X, a molecule that is required during the reaction, but
remains unchanged after the reaction. They accelerate the O3 destruction previously mentioned
in Equation 2.4. For the Chapman cycle, typical catalists include the groups HOx (H, OH,
HO2), NOx (NO, NO2), ClOx (Cl, ClO), and BrOx (Br, BrO).

X + O3 −−→ XO + O2
XO + O −−→ X + O2

Overall: O + O3 −−→ O2 + O2

As catalysts are not removed from the cycle, they are available for further O3 destruction. HOx

and NOx can cycle through this reaction scheme 1000 – 10 000 times before they are removed
from the atmosphere through chemical reaction or sedimentation. Since these reactions are
much faster than the reaction of O3 with O, the catalysts have a strong influence on the
chemistry of stratospheric O3. By taking these catalytic reactions into account, the predicted
O3 concentrations decreased and for the first time it was possible to match predicted and
measured vertical O3 profiles (see Figure 2.3, left panel).

2.2.3 Anthropogenic Influence on the Total Ozone Column
Ever since the mid 80s, the average global total O3 columns have been decreasing. The total
O3 decrease after considering natural variations is about 5% per decade (see Figure 2.3, right
panel). This decrease can be seen in mid latitudes, and is not restricted to the regions over
Antarctica affected by the ozone hole (see Section 2.2.4). O3 destruction by chlorofluorocarbons
(CFCs) was detectable as early as 1974. These gases are industrially produced compounds
containing carbon (C), fluorine (F) and chlorine (Cl). They found widespread use as cooling
agents and gas propellants in spray cans by the 1950s. CFC molecules are chemically inert in
the lower troposphere. However, upon reaching the upper area of the ozone layer at an altitude
of about 30 km, CFCs are photolyzed by shortwave UV radiation, contributing to catalytic O3
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Figure 2.3: Left: The Chapman cycle alone predicts O3 mixing ratios approximately twice as
high as the measured values. Only by taking the catalytic ozone destruction into account the
measurements could be understood. Right: Decrease in global O3 after removing all known
natural variations.

Figure 2.4: Global CFC production by year for industrialized and developing nations.

destruction. Through this process, the Cl concentration in the atmosphere was increased by a
factor of 6 within a few decades.
By the mid-1980s, scientists realised the influence of CFCs on O3 destruction. In 1987, the in-
dustrialized nations signed the Montreal Protocol to reduce CFC emissions, followed by several
additional treaties thereafter. Figure 2.4 shows the global CFC production between 1986 and
1996.
Due to the long lifetimes of CFCs in the atmosphere (up to 100 years for some species), they
continue to act as catalysts in O3 destruction even though emissions have been drastically
reduced. In very recent years, the measured ozone hole has seemed to decrease in size and
intensity. However, it will still take several decades for the ozone layer to recover.1

2.2.4 The Ozone Hole
In the middle of the 1980s, scientists predicted that the maximum O3 loss due to destruction
by CFCs would be 10%. However, in October of 1984, more than 40% of the O3 in the ozone
layer above Antarctica were destroyed.

1For details, see Scientific Assessment of Ozone Depletion, WMO, 2010 at www.wmo.int
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Figure 2.5: Left: Altitude profile of the ozone concenration measured over Antarctica in
August 1997 and October 1997. Right: Time series of the annual minimum of the measured
ozone column density.

At the end of August, the O3 column over Antarctica decreases rapidly. It reaches a minimum
in September. In November, the values increase back to normal levels.
O3 is destroyed only in the altitude range of 12 km – 30 km, as shown in Figure 2.5. However,
this is also where the ozone layer is normally located. These findings could not be explained by
dynamic processes alone. Instead, a complex chemical mechanism was found to be responsible.
Cl and Br reach the polar stratosphere in the form of transport-gases such as CFCs. Here, they
react to so-called reservoir gases, which binds the molecules and removes from from ozone-
destroying reactions. During the polar night, a combination of two processes then combine to
again release these halogens.
For one, a polar vortex forms in the stratosphere. Tropical air masses are transported towards
the poles and are deflected by the coriolis force. The large temperature gradient present in
the Antarctic winter from July to October causes the air to swirl around the south pole in a
stable stratospheric vortex, effectively shielding the south pole from other adjacent air masses.
In the absence of sunlight, the air in the Antarctic stratosphere then cools to temperatures
around −80 ◦C. At these very low temperatures, a second phenomenon takes place. So-called
Polar Stratospheric Clouds (PSC) are formed from ice, nitric acid, and some sulfuric acid. The
extreme conditions necessary to form such clouds are only present during the Antarctic winter
in the absence of sunlight in altitudes between 15 km - 25 km. Once formed, the PSCs very
effectively activate halogens through the following heterogeneous reactions taking place on the
ice surfaces.

XONO2 + H2O −−→ HNO3 + HOX (2.5)
XONO2 + HX −−→ HNO3 + X2 (2.6)

with X = {Cl, Br}.
Without the PSC surfaces, these reactions would be very slow and therefore irrelevant. When
the Sun rises in the Antarctic spring, the activated halogens act very effectively as catalysts
for ozone destruction. In the Arctic, the distribution of land masses prevents the formation
of a very strong polar vortex, therefore Arctic ozone hole is much less pronounced than the
Antarctic version. If all conditions remain the same, the ozone layer should recuperate by the
middle of the coming century. However, some aspects are still poorly understood. For example,
when ozone absorbs UV radiation, it heats the stratosphere. Ozone depletion therefore leads to
a cooling trend in the stratosphere, which could lead to an increased abundance of PSCs and
therefore even stronger ozone destruction. These and other questions are still being explored
to date.
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Chapter 3

Atmospheric Chemistry II:
Nitrogen Oxides

The Nitrogen oxides NO (nitric oxide) and NO2 (nitrogen dioxide) are together referred to as
NOx. They are one of the most problematic pollutants in urban areas not only in developing,
but also in industrialised countries. They are key species in the control of tropospheric O3
production and by this play an important role in the formation of the so-called Los Angeles Smog
(Section 3.4). Moreover, the concentration of NOx has a strong influence on the atmospheric
level of hydroxyl radicals (OH), which initiates the degradation of most oxidizable trace gases
[7].

3.1 Health Aspects of NO2 Air Pollution
NO2 is a brown, toxic gas. Mixing ratios over 20 ppm cause strong irritations of the respiratory
system including tickling of the throat, headaches, dizziness, and eventually nausea. At higher
mixing ratios, it can lead to death, 700 ppm after 30 minutes are lethal. Inhaled gas together
with the humid mucosae creates nitric acid (HNO3), which causes strong degradation of the
lungs capillaries (Air Liquide EG-safety data sheet). In addition to being a health hazard in
itself, NO2 is a precursor of a number of harmful secondary pollutants, including the formation
of inorganic particulate matter via HNO3, and photo oxidants (e.g. O3 and PANs1). These
relationships are shown in Figure 3.1.

3.2 Sources and Sinks of Tropospheric NOx

The global emissions of NOx are caused by both human activities and natural processes. Table
3.1 shows the sources of NOx and their contributions to the global emissions.
New highly resolved satellite measurements allow to determine the global distribution of these
NOx sources. Figure 3.2 depicts the 18 month mean of a satellite measurement of NO2, which
was recorded by the SCIAMACHY instrument aboard the ESA satellite ENVISAT. Areas with
high VCDs correlate with urban areas and therefore also with anthropogenic sources. In fact,
more than half of the global NOx emissions are man-made.
The major source of anthropogenic NOx is the combustion of fossil fuels in industrial processes,
power plants, and traffic. The most important mechanism for natural and anthropogenic
production of NOx is the Zel’dovic cycle [38] which describes the formation of thermal NO.
The term thermal is chosen due to the high activation energy necessary for Reaction 3.2 of

1peroxyacyl nitrates
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Figure 3.1: Simplified relationship of NOx emission with formation of NO2 and other harmful
reaction products including O3 and particulate matter (PM2.5) [36].

318 kJmol−1. Therefore, NO is emitted from combustion processes, e.g. in combustion engines
(traffic) and from thermal power plants or other industrial combustion processes.

O2 +M −−→ O+O+M (3.1)
O+ N2 −−⇀↽−− NO+ N (3.2)
N+O2 −−⇀↽−− NO+O (3.3)
N+OH −−⇀↽−− NO+ H (3.4)

Afterwards, NO2 can be produced via Reaction 3.7. NOx is removed from the atmosphere
mainly by further oxidation. During the day, hydroxyl radicals oxidize NO2 to HNO3, which is
then removed from the atmosphere by wet (acid rain) and dry deposition:

NO2 +OH+M −−→ HNO3 +M (3.5)

Another sink of NOx is the reaction of NO2 with O3. Although the rate coefficient for this
reaction is relatively small, it cannot be neglected in areas with high O3 concentrations in
the absence of sunlight. During daytime, this reaction plays no role because NO3 is rapidly
photolyzed. During the night, NO3 reacts with NO2 to form the anhydrite of nitric acid N2O5.
The major sink of tropospheric N2O5 is hydrolysis and subsequent wet or dry deposition [19].

3.3 Photostationary State with Ozone
NO2 is mainly a secondary pollutant. The oxidation to NO2 is explained by [16].

Table 3.1: Summary of the main anthropogenic and natural sources for global tropospheric
NOx. Taken from e.g. [15].

Sources Emission / Mt yr−1 Range of Uncertainty / Mt yr−1

Fossil fuel combustion 22 13-31
Biomass burning 7.9 3-15
Soil microbial production 7.0 4-12
Lightning 5.0 2-20
Aircraft 0.8 0.59-0.95
Stratospheric 0.64 0.4-1
Total 44 23-81
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Figure 3.2: Satellite measurement of the NO2 VCD averaged over the time period from January
2003 to June 2004. The measurements have been performed with the SCIAMACHY instrument
aboard the ESA satellite ENVISAT. [1].

O(3P) +O2 +M −−→ O3 +M (3.6)
O3 + NO −−⇀↽−− NO2 +O2 (3.7)
NO2 + hν −−→ NO+O(3P);λ < 410 nm (3.8)

The third reaction partner in Reaction 3.6 is required due to conservation of momentum. The
photolysis in Reaction 3.8 only occurs at wavelengths below 410 nm.
The steady state concentrations of O3, NO, and NO2 are linked by the Leighton ratio:

[NO]

[NO2]
=

jNO2

kO3+NO · [O3]
(3.9)

kO3+NO is the reaction constant for Equation 3.7. Since the photolysis rate changes with the
SZA, the Leighton ratio also changes during the course of the day. At noon of a clear day,
when the photolysis rate has its maximum of jNO2 ≈ 8 × 10−3 s−1, the Leighton ratio has its
maximum and the lifetime of NO2 is about 2min. At typical O3 mixing ratios of 30 ppb, [NO]

[NO2]

is on the order of 1.

3.3.1 NO2 Diurnal Cycle
In an atmosphere that is free of volatile organic compounds (VOCs), NO2, NO and O3 are in a
self-contained diurnal cycle that is strongly dependent on the Sun’s UV light. In the morning,
the intensity of solar light increases. This leads to photodissociation of NO2. During the day,
NO and NO2 are in a photostationary balance (see Reactions 3.6 to 3.8).
Due to the dissociation of N2O5 to NO2, the statospheric mixing ratio of NO2 increases during
the day.

N2O5 + hν −−→ NO2 + NO3 (3.10)
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NO3 rapidly splits up to form either NO2 or NO. This only happens during the daytime.

NO3 + hν −−→ NO+O2 (3.11)
NO3 + hν −−→ NO2 +O (3.12)

In the evening, the photolysis decreases and Reaction 3.8 no longer creates NO. The result is
an increase of NO2. At night, NO2 forms N2O5 again.

NO2 +O3 −−→ NO3 +O2 (3.13)
NO3 + NO2 +M −−→ N2O5 +M (3.14)

3.4 Photochemical Smog / Deviation from the Photosta-
tionary State

Since the first reports of photochemical smog in Los Angeles in the late 1940’s, extremely high
O3 levels have been measured in urban areas throughout the whole world. In Mexico City, O3
levels over 400 ppb have been reported. Photochemical smog is worst when high levels of volatile
organic compounds (VOCs) and NOx are emitted into a thermal inversion layer, trapping them
closely to the ground, and irradiated by sunlight during transport to downwind regions. This
section discusses the mechanisms responsible for the creation of photochemical smog.
The Leighton relation is only valid if Reactions 3.6 to 3.8 describe the major sources and sinks
of NO2 and O3. In the presence of VOCs, another reaction path for the conversion of NO
to NO2 exists which does not include the destruction of O3. The OH radical which usually
initiates the reaction chain is mainly formed by means of ozone photolysis:

O3 + hν −−→ O(1D) +O2;λ < 320 nm (3.15)
O(1D) + H2O −−→ 2OH (3.16)

The reaction chain is started by the oxidation of a hydrocarbon (RH), which may be described
as

RH+OH −−→ R+ H2O (3.17)
R+O2 −−→ RO2 (3.18)

The peroxy radicals RO2 and HO2 react with NO and produce NO2 without destroying O3 (see
e.g. [2, 4, 20]).

RO2 + NO −−→ NO2 + RO (3.19)
RO+O2 −−→ R′CHO+ HO2 (3.20)

HO2 + NO −−→ NO2 +OH (3.21)
This scheme can be applied multiple times until the initial VOC is converted to CO2 or CO
and H2O. Together with the Reactions 3.6 to 3.8, this can be written as an effective equation
for the O3 production:

RH+ 4O2 + 2hν −−→ R′CHO+ H2O+ 2O3;λ < 410 nm (3.22)
The reaction system is illustrated in Figure 3.3 together with the most important sources of
OH, hydroxyl, and peroxy radicals.
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Figure 3.3: Reaction cycles of tropospheric NOx and O3 in a polluted atmosphere. The
photostationary state of NOx is illustrated by the blue cycle. It is disrupted by the presence of
VOCs, which results in a net production of O3. [31]
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Chapter 4

DOAS

Differential Optical Absorption Spectroscopy (DOAS) is a widely used technique in atmospheric
research for the detection of numerous trace gases, such as O3, NO2, formaldehyde, halogen
radicals (BrO, IO), H2O, and many others [21, 22]. This chapter will cover an approximative
radiative transfer model for the application to the DOAS method.

4.1 The Beer-Lambert Law
When electromagnetic radiation passes through matter, its intensity is modified. For this ex-
periment, the dominant processes are absorption and scattering. These are extinction processes,
meaning they reduce the intensity of radiation. This reduction depends on the wavelength of
light and the amount of matter it travels through, and is described by the Beer-Lambert law.
Let I0(λ) be the intensity of a light beam at wavelength λ before entering the medium and
I(λ) be the intensity after passing through it. Then the relationship between incident and
transmitted intensity is

I(λ) = I0(λ) · exp (−τ(λ)) (4.1)
= I0(λ) · exp (−σ(λ) · ρ · L) , (4.2)

where τ is the optical density, σ is the extinction cross-section and ρ is the concentration of
the trace gas, and L is the length of the layer the light passed through. In general, σ depends
on pressure and temperature along the light path. Furthermore, the concentration along the
light path can vary. The Lambert-Beer law describes the absorption for N different absorbers
i through

I(λ, L) = I0(λ) · exp
(
−
∫ L

0

N∑
i=1

σi(λ) · ρi(s) ds
)

. (4.3)

4.2 The DOAS Method
To determine the concentration of a particular trace gas in the atmosphere, it would, in prin-
ciple, be necessary to quantify all factors influencing the intensity I(λ) of a spectrum of light.
In the laboratory, this can be achieved by removing the absorber from the light path. In the
atmosphere, however, where this is impossible, the multiple factors influencing the intensity
pose a dilemma. DOAS overcomes this challenge by using the fact that many processes in
radiative transfer show broad or even smooth spectral characteristics, while certain trace gases
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Figure 4.1: Light with the initial intensity I0(λ) is emitted by a light source. After passing
through a volume of air containing an absorber with concentration ρ, the detector measures
the reduced intensity I(λ).

exhibit narrowband absorption structures. The basic principle of DOAS is thus the separation
of spectral structures in narrowband (varying strongly with wavelength) and broadband (vary-
ing slowly with wavelength) components in differential spectra, so that changes in narrowband
absorptions can be detected (illustrated in Figure 4.4). To use Equation 4.3 in DOAS mea-
surements, it therefore has to be modified according to properties of radiative transfer in the
atmosphere and the measurement principles of DOAS instruments.

4.2.1 Narrowband Components
Fraunhofer Reference Spectrum

The Sun’s spectrum is highly structured (see Figures 2.1 and 4.3, top). These structures must
be taken into account in a DOAS retrieval when using a passive instrument, i.e. when using
the Sun as a light source. This is usually achieved by using a so-called Fraunhofer reference
spectrum I0(λ), which is a solar spectrum recorded under conditions in which the investigated
trace gases show little or no absorption.

Trace Gas Absorption

The primary quantity measured by DOAS instruments is the slant column density (SCD). The
SCD which we denote as Si(λ) is defined as

Si(λ) =

∫ L

0

ρi(s)ds . (4.4)

It is an integrated quantity and has the units molecules cm−2.
Each trace gas has its individual absorption cross-section σi which serves as a spectral finger-
print. Several trace gases can be measured simultaneously even if their absorption features are
superimposed (see Figure 4.2). By fitting these cross-sections to recorded differential spectra,
SCDs are retrieved for each gas individually.
If the Fraunhofer reference spectrum already contains absorption of a trace gas, the SCD is
often called differential Slant Column Density (∆SCD or ∆S).

∆Si = Si − S0,i , (4.5)

where S0 is the SCD of the Fraunhofer reference spectrum containing its extinction effects.

The Ring Effect

In 1961, J. Grainger and J. Ring [11] discovered that the the depth of the Fraunhofer lines was
smaller when examining scattered sunlight than when direct sunlight is observed. This was at-
tributed to inelastic rotational Raman scattering [32], which slightly changes the wavelength of
the scattered photon when the scattering occurs. This causes a ”filling in” of strong absorption
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Figure 4.2: UV/Vis absorption cross sections of atmospheric trace gases detectable by DOAS.

lines, as wavelengths on either side of the line are shifted into it. The magnitude of the so-called
Ring effect depends on the atmospheric path lengths of the photons entering the spectrometer.
The longer the path in the lower atmosphere where the air density is higher, the more likely
a Raman scattering event becomes. Therefore, the Ring effect is dependent e.g. on the solar
zenith angle, the cloud cover and the aerosol concentration in the atmosphere. To correct for
the Ring effect, a so-called Ring spectrum R(λ) is calculated (e.g. by DOASIS, Figure 4.3).

4.2.2 Broadband Components
The light is affected by scattering and absorption on aerosol particles and cloud droplets (Mie
scattering) and by scattering on air molecules (Rayleigh scattering) 1. Both Mie scattering εM
and Rayleigh scattering εR are elastic, i.e. the wavelength of the scattered photons remains

1More precisely, we mean the Cabannes line of Rayleigh scattering. In a strict nomenclature, Rayleigh
scattering also includes rotational Raman lines (mentioned above), but these are treated separately in the
DOAS approach because of their effect on narrowband spectral structures. For clarity, see [37].
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Figure 4.3: An example of a Fraunhofer spectrum (top) and the Ring spectrum calculated
from it (bottom).

constant during the process and have their respective cross-sections. The Rayleigh scatter-
ing probability is proportional to λ−4, so shorter wavelengths are more likely to be scattered
than long wavelengths. This is the reason why the sky appears blue. Mie scattering is much
less dependent on wavelength, so clouds and fog appear white, as all wavelengths are equally
scattered.
For the sake of integrity it should be noted that some trace gas cross sections also have broad-
band parts σi0(λ) in addition to the narrowband parts mentioned above.

4.2.3 Modified Lambert-Beer Law
Considering sections 4.2.1 and 4.2.2, we expand Equation 4.3:

I(λ, L) = I0(λ) · exp
(
−R(λ)−

∑
i

σi(λ) · Si(λ)

)
· (4.6)

exp
[
−L ·

(∑
i

(σi0(λ) · ρi) + εR(λ) + εM(λ)

)]
Here, the first exponent contains all narrowband components and the second exponent contains
all broadband components.

4.2.4 The DOAS fit
Solving equation 4.6 for ln(I/I0) yields the optical density τ :

τ = ln
(
I(λ)

I0(λ)

)
(4.7)

= −R(λ)−
∑
i

σi(λ) · Si(λ)−
∑
k

bkλ
k

Here,
∑

bkλ
k is a polynomial to account for the second exponent of equation 4.6, which includes

all broad band features, as mentioned in section 4.2.2. R(λ) is the Ring spectrum and σi(λ)
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Figure 4.4: The principle of DOAS: The optical density τ is the result of narrow σi and
broadband parts σi0 of an absorption cross section. Adapted from [22].

and Si(λ) are the cross section and the slant column density of trace gas i, respectively. Apart
from atmospheric effects, the instrument itself also modulates the signal: The signal from light
reflected from elements in the spectrometer or the 0th or 2nd order of scattering from the
grating are called spectrometer stray light. If stray light intensity varies over the spectrum,
absorption bands at different wavelengths will be changed differently, i.e. the optical density
will be reduced more for some parts of the spectrum than for others. In order to account for
this, a so-called ’Offset’ polynomial IOfs(λ) can be added in the fitting procedure (see equation
4.8).
The idea of the DOAS fit is fairly simple. A model is used to construct an optical density
by taking into account all the physical effects the light entering the instrument undergoes.
This modelled optical density is then compared to the measured optical density. By varying
the physical parameters of the model (which include the trace gas column densities Si), the
difference between model and measurement are minimized. When the minimum is reached, the
physical parameters of the model are assumed to represent those of the measurement.
Due to noise in the measurement (see section 4.4.3), the modelled optical density can never per-
fectly match the measured optical density. Therefore, the DOAS fit searches for the minimum
quadratic deviation (dependencies omitted for readability):

χ2 =

[
ln
(
I0 + IOfs

I

)
−R−

∑
i

σi · Si −
∑
k

bkλ
k

]2
(4.8)

The unexplained remainder of the spectrum after minimisation (by varying the parameters Si

and bk) is called the fit residual. The smaller the residual, the better the fit has succeeded in
modelling the trace gas absorption. Ideally, the residual is only composed of noise. In order
to detect a trace gas, its optical density needs to be larger than the residual. This criteria can
be used to estimate the detection limit for a particular species. Once the minimum was found,
the fit parameters Si represent the column densities of the individual trace gases.

4.3 Calculating trace gas concentrations
Depending on the measurement geometry, the column densities obtained with the evaluation
described above need to be interpreted in different ways. One way is the assumption of simplified
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Figure 4.5: Light path through the atmosphere in the case of small (left) and large (right) solar
zenith angle. With larger SZA, the light path through a stratospheric absorber is enhanced.

geometrical approaches (like in this experiment as described in the following sections), but in
more complex cases, extensive radiative transfer simulations have to be carried out (section
4.3.4). The observation geometry can be described by the solar zenith angle (SZA) θ (angle
between the zenith and the sun) and the telescope elevation angle α (angle between the horizon
and the viewing direction). The light path also depends on the solar relative azimuth angle
(SRAA), which is neglected here.

4.3.1 Active measurements
Active measurements are measurements with an active or artificial light source. In modern ap-
plications, often LEDs are used because of their well defined spectra. For active measurements,
the interpretation of the retrieved column densities is the simplest, because the light path is
clearly defined. It runs from the light source to the DOAS instrument. Dividing the column
density by the length of the light path directly yields the average trace gas concentration along
the light path. There are some similar applications, where the instrument points directly at
the sun or the moon (direct light measurements).

4.3.2 Zenith sky measurements
Zenith sky measurements are performed by looking straight up with a passive instrument. In
this geometry, the exact light path is unclear, but radiative transfer models can be used to
make a statistical prediction about the average path. In order to compare different SCDs
(which depend on the light paths), one can calculate the Vertical Column Density (VCD or V )
from the SCDs with the help of the so-called Air Mass Factor (AMF or A):

AMF = A(θ) :=
S(θ)

V
≈ 1

cos(θ) (4.9)

This approximation for the case of zenith sky measurements (valid for θ < 75°) is illustrated in
figure 4.5. The Fraunhofer reference is typically taken at the minimal solar zenith angle around
noon. Therefore, the retrieved column densities are all relative to this value. The total SCD is
the sum of the ∆S and the column density already present in the Frauhofer spectrum SF .

S = ∆S + SF (4.10)

SF can be extracted with the help of a Langley Plot.
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Langley plot

In a so-called Langley Plot, the measured ∆SCD is plotted as a function of the air mass factor
AMF. If the concentration of a measured trace gas is constant during the course of the day the
correlation between the ∆SCD and the AMF will be linear:

V =
S(θ)

A(θ)
(4.11)

=
∆S(θ) + SF

A(θ)

⇒ ∆S (A (θ)) = V · A (θ)− SF (4.12)

Here, θ is the solar zenith angle. If a constant concentration is assumed, the resulting plot
can be extrapolated to A = 0. Here, ∆S = −SF , and the column density in the Fraunhofer
reference spectrum can be retrieved (see figure 4.6). Note that the assumption of a constant
concentration is only valid for a few atmospheric absorbers, e.g. stratospheric ozone.

Figure 4.6: Two examples of Langley Plots. The left panel depicts the Langley Plot of an ozone
measurement. Extrapolation yields a Fraunhofer SCD of approximately 1019 molec/cm2. The
panel on the right is a Langley Plot of a nitrogen dioxide measurement. Here, the concentration
is not constant during the course of the day, and the extrapolation does not yield a definite
value.

4.3.3 Multi-Axis-DOAS
The method of multi-axis DOAS (MAX-DOAS) strongly enhances the sensitivity for trace gases
located in the troposphere (for details, see [13]). When observing light with small elevation an-
gles α (angle between the horizon and the viewing direction of the instrument), the light paths
through the lowermost atmospheric layers (and the SCDs of trace gases present there) are
strongly enhanced, as shown in figure 4.7. However, the light path through the stratosphere
does not change with elevation angle α. This offers the opportunity to distinguish between
stratospheric and tropospheric trace gases. This usually means recording the Fraunhofer ref-
erence spectrum in the zenith direction to minimize the light path through the lower layers of
the atmosphere. The airmass factor of a trace gas near the surface measured at an elevation
angle α can be approximated by:

A(α) ≈ 1

sin(α) (4.13)
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However, light paths can become very complicated. For very small elevation angles, parts of the
observed light are scattered within the trace gas layer. Multiple scattering can occur for high
aerosol loads and under cloudy conditions. The geometric approximation (equation 4.13) is not
valid anymore under these conditions. An example of MAX-DOAS measurements is shown in
figure 4.8.

Zenith

Troposphere

Scattering

�

Tropospheric
Absorber

Stratosphere

Figure 4.7: Observation geometry of MAX-DOAS measurements.
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Figure 4.8: NO2 SCDs measured with a MAX-DOAS instrument in Heidelberg. Different colours
indicate different telescope elevation angles. The SCD increases with decreasing elevation angle,
indicating the presence of NO2 near the surface. The U-shape of the diurnal profile is caused
by stratospheric NO2.
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4.3.4 Complex scenarios
In case of heavy aerosol loads, clouds and more complex measurement geometries, such as from
satellites, aircraft and ships, the approximations described above are no longer useful, because
the light path distributions can become very complex. For example, figure 4.9 illustrates two
basic cases for cloud influence on light paths. Light path distributions can be simulated by
radiative transfer models (figure 4.10). A Levenberg-Marquardt algorithm [17, 18, 24, 25] then
searches for minima in a χ2 landscape to retrieve radiative transfer model parameters (e.g.
aerosol load and trace gas concentrations) that best represent measured slant columns on the
one hand and knowledge about the atmosphere on the other hand. Examples of this approach
can be found in e.g. [8, 9, 14, 23, 33].

Figure 4.9: Left: for clear sky, sun light is scattered by air molecules and aerosol particles
towards the instrument. Center: diffusing screen effect: in the presence of thin clouds, a
substantial fraction of the observed photons is scattered by the cloud; especially for the smaller
elevation angles, this effect leads to an increase of the absorption path. Right: for optically
thick and vertically extended clouds, multiple scattering can lead to a very large increase of the
photon paths inside the clouds. [34]

Figure 4.10: Three different perspectives of events simulated by McArtim, a 3D backward trajec-
tory monte-carlo radiative transfer model, when observing a cumulus cloud at 670 nm. Green
points represent cloud and aerosol particle scatter events, blue points depict absorption events.
Ground scattering is shown in yellow and red dots symbolize Rayleigh scattering by air molecules
and hint to the lines of sight of the instrument. [6]

4.4 Background and noise
The spectra are collected by grating spectrometers with CCD detectors. The properties espe-
cially of the detectors have to be taken into account in order to correctly record and process
the spectra.
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4.4.1 Electronic offset
The offset is an electronic signal (e.g. an analogue voltage or current) which is added to the
photon induced signal of each pixel for every exposure, because the AD-converter can not
convert a negative input. The offset can therefore best be measured by recording an exposure
at a very low exposure time with no light entering the spectrometer, as the measured signal
will then consist almost exclusively of the offset signal. To minimize the noise, however, it is
best to record many such scans in succession. For the Ocean Optics USB2000, e.g., typically
10000 scans at 3 ms (minimum exposure time of this spectrometer) exposure time are recorded
(figure 4.11, left panel). As the offset is added to each scan, the resulting spectrum must first
be scaled to the measurement spectrum by the number of scans before it is subtracted:

IOS(n) = I(n)− NMeas

NOS

·O(n) (4.14)

Here, I(n) is the intensity measured at each pixel n, O(n) is the electronic offset, and N is the
number of scans with which the respective spectra were recorded.
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Figure 4.11: Left: Offset spectrum recorded with an Ocean Optics USB2000 spectrometer.
Most pixels have an average offset of about 221 counts/scan. For a typical measurement with
saturation 75%, this is approximately 7% of the measured signal. Right: Dark current spectrum
recorded at an exposure time of 60 seconds with a USB2000 spectrometer. Most pixels register
a dark current of less than 4 counts per second, but a few so-called hot pixels register much
more.

4.4.2 Dark current
The dark current is caused by thermally excited electrons which pass the semiconductor band
gap due to Boltzmann statistics. Therefore, it strongly depends on the temperature of the
detector. In many spectrometers, the detectors are cooled to keep the dark current low. This
is especially important for modern UV-sensitive back-thinned detectors, as the dark current is
very high otherwise.
For a constant temperature, the dark current signal is proportional to the exposure time.
To measure the dark current it is therefore best to use a long exposure time and only one
exposure, so the offset is only added once. Of course no light should enter the spectrometer
during the measurement. For the USB2000, the maximum exposure time is 60 seconds (figure
4.11, right panel). After the measurement is recorded, the offset must be corrected and the
remaining signal is the dark current. When correcting for the dark current of a measurement
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spectrum, the measured dark current must be scaled to the measurement exposure time before
it is subtracted:

IDC(n) = I(n)− tMeas

tDC

·DOS (4.15)

Here, I(n) is the intensity measured at each pixel n and DOS is the measured dark current
after correcting for the electronic offset. Before subtracting it, it is multiplied by the ratio of
the measurement exposure time and the dark current exposure time.

4.4.3 Noise
Two spectra will never be perfectly identical, even if they are recorded under identical condi-
tions. The reason for this is statistic noise in the photon signal and the detector background
signal and additionally systematic noise. The statistic noise can be quantified. A measurement
spectrum I = IB + IP is always composed of the background IB and the signal induced by the
incident photons IP . If multiple spectra are recorded under identical conditions, both contri-
butions will fluctuate around a mean value. Gaussian error propagation yields the following
equation for the total noise σ:

σ =
√

σ2
B + σ2

P (4.16)

The background noise σB is a property of the instrument and is therefore often referred to as
instrument noise. It is composed of fluctuations in the electronic offset and the dark current.
The photon noise σP is a fundamental physical phenomenon. For a given light intensity, the
number of photons in a certain time interval fluctuates. The number of registered photons is
then distributed according to the Poisson distribution: If M photons are registered on average
for a given time interval, the root mean square (RMS) of the obtained distribution will be

√
M .

Spectroscopy instruments are designed so that the photon noise, not the instrument noise limits
the instrument precision (see figures 4.12 and 4.13).

To measure both the instrument and the photon noise, two spectra I1 and I2 are recorded in
quick succession, so the magnitude of the noise contributions in the two spectra can be assumed
to be equal. If the two spectra are then subtracted from each other, the noise of the difference
σD calculates to:

σD =
√

σ2
I1
+ σ2

I2
(4.17)

=
√

2σ2
I (4.18)

⇒ σIi =
1√
2
σD (4.19)

Note that this is the average noise over all pixels. The instrument noise can vary 20-30 %
from pixel to pixel in modern CCDs [27]. In order to be entirely precise one would therefore
have to characterise the instrument noise of each pixel separately, but since under reasonable
measurement conditions photon noise largely dominates the overall noise in a spectrum, it is
not necessary to deal with this ’noise of the instrument noise’. When collecting more and more
light, at a certain point all statistical noise is so small that only systematic noise remains in
the residual.
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Figure 4.12: Noise measurements of a modern DOAS spectrometer. All statistical noise can
theoretically be reduced indefinitely by adding up more photons (scans), but at a certain point
systematic noise remains. [10]

Figure 4.13: Calculation of the statistical noise contributions in a single readout of a modern
CCD for different saturations. Photon noise is the largest statistical noise source for saturations
> 5 %. [27]
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4.5 Summary
Each measured spectrum is composed of several superimposed signals:

1. Background. The background signal is the measured signal when no light enters the
spectrometer (section 4.4). It consists of:

• Electronic offset: Proportional to the number of scans recorded.
• Dark current: Proportional to the exposure time.

2. Narrowband effects (section 4.2.1)

• Fraunhofer spectrum: The Fraunhofer spectrum is the spectrum of the sun as it
arrives at the top of the earth’s atmosphere. It already contains many very strong
absorption structures. These are caused by light absorption by species in the sun’s
outer layers (photosphere).

• Trace gas absorption: Trace gases in the atmosphere create characteristic absorption
structures in the measured spectra. The goal of the DOAS retrieval is to identify
and isolate these structures, which typically feature optical densities between 10−3

and 10−1.
• Raman scattering: Inelastic scattering filling in Fraunhofer lines.

3. Broadband effects (section 4.2.2)

• Broadband absorption cross sections
• Rayleigh & Mie scattering: Elastic scattering either by air molecules (Cabannes line

of Rayleigh scattering) or by small water droplets or particles called aerosols (Mie
scattering).

• Spectrometer stray light (section 4.2.4)

4. Noise (section 4.4.3)

• Instrument noise: The dark current signal follows a Poisson statistic and its noise is
therefore proportional to the square root of the dark current signal. The offset noise
is proportional to the square root of the number of scans. Therefore, the instrument
noise (made up of offset and dark current noise) is also proportional to the square
root of the number of scans.

• Photon noise: The photon signal follows a Poisson statistic. Its noise (shot noise) is
therefore proportional to the square root of the signal.

• Systematic noise: Sources for systematic noise can be unexplained physical changes
in the instrument or in the atmosphere. Can you think of some sources of systematic
noise in this experiment?

The optical density τ calculated from two spectra I and I0 is then fitted with the least squares
method according to equation 4.8. The resulting slant columns S can be converted to vertical
columns and concentrations with knowledge about the light path, see section 4.3.
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Chapter 5

Experimental setup

This experiment is conducted at the Institut f�r Umweltphysik (INF 229), Room 238. During
the course of the measurements, the spectra of scattered sunlight as well as those of some
artificial light sources will be examined. In both cases, a telescope is used to collect the light.
For the atmospheric measurements, a telescope mounted on the roof of the building is used
(see figure 5.1). For the laboratory studies, another telescope mounted on an optical bench is
employed (figure 5.2).

5.1 General setup
The respective telescope is connected to the spectrometer with a 400 µm diameter quartz fibre
bundle with a numerical aperture of 0.22 and protected by a metal tube. The quartz fibre is
easily damaged, so please handle it with care. The fibres of the spectrometers can either be
connected to the roof telescope fibres or to the lab telescope by couplings.
The spectrometers are located in a metal housing. This housing contains thermoelectric cool-
ing units which are used to stabilize the spectrometer temperature. The data recorded by the
spectrometer is sent to a PC via the USB interface. Figure 5.2 gives an impression of the
instrumentation.

5.2 The spectrometer
The commercial miniature spectrograph-detector unit Ocean Optics USB2000 represents the
heart of the DOAS instrument. It is built in the Czerny-Turner design (see Figure 5.3). The
light entering the spectrometer through a slit is collimated by a spherical mirror and pro-
jected on a grating as a parallel light beam. The grating disperses the light into its spectral
components. A second spherical mirror focuses the light on a detector, which consists of a
one-dimensional CCD array with 2048 pixels.
The most important features of the detector are:

Number of pixels: 2048
Pixel size: 14µm× 200µm
Full Well Capacity per pixel: 100 000 electrons
A/D - Converter: 12 Bit (i.e., 4096 Counts/Pixel)
Integration time: 3 ms - 65 s
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Figure 5.1: Telescopes to collect scattered sky light.

34



Figure 5.2: Laboratory instrumentation.
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Figure 5.3: The USB2000 spectrograph with detector. 1: fibre connector; 2: entrance slit; 3:
optical filter; 4: collimating mirror; 5: grating; 6: focusing mirror; 7: collection lens; 8: CCD
detector.
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Chapter 6

Software

This chapter describes which software is to be used to complete the experiment. The computer
in use runs on a Windows 10 environment for evaluation and internet access, while the mea-
surement system is a Windows XP virtual machine. This is required for the software DOASIS.

6.1 DOASIS
During this experiment, you will use the DOASIS (DOAS Intelligent System) software, which
was developed at the Institut f�r Umweltphysik in the scope of a PhD. DOASIS can be used
to acquire data from the spectrometer and display it in a graphic user interface for evaluation.
The program is written for Microsoft Windows, uses a typical Windows interface, and should
therefore be easy to learn. When conducting measurements and performing data evaluations
’by hand’, all functions are accessed via the menus at the top of the window. However, all
functions can also be called from jscript programs. These scripts allow the automation of data
acquisition and evaluations.
The DOASIS user interface is split into 4 areas, as shown in figure 6.1.

• Spectrum Sheet: This area is used for viewing the spectra. You can switch between all
open spectra by clicking on the tabs at the top of the spectrum sheet. The y axis is
automatically scaled to fit the displayed spectra. You can zoom in to any part of the
spectra by holding the left mouse button down and dragging the mouse.

• SpecBar: You can use the Specbar to switch between open spectra. Alternatively, this
window can be used to control the spectrometer by clicking on the PDA tab.

• Information window: This area gives you information on the current spectrum. You can
switch between Statistics such as maximum, minimum, average and standard deviation
(called Deviation) and Properties such as exposure time and number of exposures.

• Console: The console can display different things, depending on which tab you select:

1. Output gives you information about called functions or running scripts.
2. Script is used to start, stop and edit scripts.
3. Mini Scripts can be used to quickly implement small scripts.
4. Quickscript allows the user to define shortcuts to certain scripts.
5. Fitting is used to run DOAS retrievals.
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Figure 6.1: The graphic user interface of DOASIS is split into 4 areas.
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First steps
1. Record a scattered light spectrum.

To do so, change from the Specbar register to PDA. Set the Device to Ocean Optics USB
2000, if this has not been done yet. Below, you can set the spectrometer’s exposure time
in milliseconds and the amount of exposures to record (NumScans), see figure 6.2. Start
the measurement by clicking on the Scan button.

2. Check the information DOASIS gives you.
In the Information window under the register Statistics you will be given statistical in-
formation about the current spectrum such as the average number of counts (Average),
the standard deviation from this value (Deviation) and the maximum number of counts
(Max). Also take a look at the Properties register.
The statistical information in the Statistics tab is calculated over the range selected with
the Math marker (green). The Math marker can be toggled in the toolbar of DOASIS
at the very top. There is also a regular Marker (black line), which shows the currently
marked channel and (if the instrument has a calibration) the currently marked wavelength.
Another important marker is the Fit Marker (red). When performing a DOAS fit, the
range of the fit is determined by this Fit Marker, and values outside of it are not considered
during this fit. The size of the the Math Marker and Fit Marker can be changed by
dragging the left and right edges at the bottom of the screen.
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Figure 6.2: Left side: In the PDA Register you can set the exposure time and number of
exposures. Right side: The Properties register contains useful information about the current
spectrum.

3. Record further spectra.
In order not to overwrite your first spectrum, use the menu command File → New... to
open a new Spectrum Sheet. Play around with the exposure time and the number of
exposures. Record an oversaturated spectrum. (Each pixel has a single exposure full well
capacity of 212 − 1 = 4095 Counts.

4. Compare two spectra with each other.
Use the menu command View → Add Overlay... to view two spectra on top of each other.
If you use the option Fit all overlays, the y axis of the overlay spectrum will be adapted
so that both spectra are fully visible on the screen.
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5. Zoom in to an area of the spectrum.
Hold the left mouse button down while drawing a rectangle around the area of interest.
The program will then zoom in to this area. Notice that the Statistics in the lower right
corner of the screen also change. They now give information about the zoomed in region
of the spectrum. Click the right mouse button on the Spectrum Sheet to zoom back out.
Note, that the zoom rectangle should be drawn from left to right. Dragging from right
to left occasionally causes errors.

6. Save your spectrum.
First, create your own folder in the directory

FPDaten\FP\FP− Praktikanten\

and save all your files into this folder (except for special cases, which are noted in this
script). If you save your files somewhere else, they will be deleted.
Open the save dialogue using File → Save As.... DOASIS supports a number of file
formats. The standard format is *.sp2. In this format, all spectrum properties are saved,
and this is the format you should use during the experiment. The save dialogue also gives
you the option to save the spectrum as a *.txt file. This can be useful if you want to, for
example, plot some spectra with Python.

Troubleshooting DOASIS
Task Manager

• The Task Manager of Windows XP inside the virtual machine may be accessed using the
key combination Ctrl + Shift + Esc.

DOASIS is crashing or freezing:

• Close DOASIS (you may need to use the Task Manager)

• Unplug the USB cable that connects the spectrometer to the computer. Plug it back in
after waiting a few seconds.

• Restart DOASIS

Cannot stop automated scripts or scan in DOASIS:

• The scripts cannot be halted. Use the Task Manager to kill DOASIS.

Accidentally closed important tabs in the UI:

• You can restore the default settings for the DOASIS UI by going to View - Docking
Windows - Reset Workspace Layout.

40



Chapter 7

Course Instructions

Please do NOT change the computer’s time!
The quartz fibre is very sensitive! Do not forcefully bend it or it will break!
The computer should be switched on and automatically record spectra. Stop the automated
measurements by clicking on the Script register on the bottom left corner of the screen, then
click on the Stop button. The program will finish the current measurement, which may take a
few minutes. If the window Terminate Script pops up, click No.
When you have familiarized yourself with the experimental setup and evaluation software, you
can begin the experimental part of the course. The first measurements will take place in the
lab room. Therefore, CAREFULLY unlock the fibre coupling. Do not touch the end of the
fibre (because of fat and liquid on your skin). In order to record dark spectra, use a tissue,
towel or something similar instead.
You should take screenshots of important spectra (DC spectrum, offset spectrum, Hg spectrum)
and your DOAS fits, as the spectrum files can only be opened with the DOASIS software.

7.1 Characterizing the instrumentation
When recording a spectrum, two parameters must be taken into account: the exposure time
and the number of exposures, also called scans. The exposure time is usually given in mil-
liseconds and represents the time the detector is exposed to incoming light. The number of
scans (called NumScans in DOASIS) tells the spectrometer how many exposures to add for
each measurement.
It is important to use the dynamic range of the instrument’s detector (see figure 4.13). If the
exposure time is chosen too short, the recorded spectrum will consist almost exclusively of
electronic offset and the noise pattern will be large. On the other hand, if the exposure time is
too long, the detector will be oversaturated and the top of the spectrum will be cut off. Why
should either situation be avoided?

The saturation T of a detector pixel P is defined as:

T (P ) =
C(P )

N · Cmax

· 100 (7.1)

Here, C(P ) is the number of counts registered in the pixel, N is the number of scans. Cmax =
4096 is the maximum number of counts the pixel can register. At saturations above 80%, the
sensitivity of the CCD detector begins to drop off. Therefore, the measured signal is no longer
proportional to the incoming photons. To avoid this, a saturation of about 70% is typically
used for atmospheric measurements.

41



In this section you will learn about the composition of a measured spectrum and how to optimize
your measurements. The spectrometer’s detector is of special importance in this respect.

7.1.1 Offset
1. Record an offset spectrum.

Cover the fibre so no light enters the spectrometer and record an offset spectrum. You
should use at least 10,000 exposures at the minimal exposure time. Save the spectrum in
the *.sp2 format and take a screenshot of it.

Determine the mean offset value per pixel per scan. Use the Statistics tab and if necessary
the menu entry Math → Scalar Operations → . . .

7.1.2 Dark current
1. Record a dark current spectrum.

Use the maximum exposure time of 60 seconds. One exposure is enough here. Save the
spectrum in the *.sp2 format and take a screenshot of it.

Do you need to correct for the offset here? If so, use the menu entry Math → Cor-
rect Offset 1 and then save the spectrum again. Determine the average number of counts
per pixel per second caused by dark current and compare this value to the offset.
Discuss the relevance of the dark current correction.

2. Record at least 5 further dark current spectra at smaller exposure times.

Is the dark current constant? Plot the average dark current signal against the exposure
time.

When correcting your measurements for offset and dark current, the Correct Offset and Correct
Dark Current functions in DOASIS will automatically deal with the calculations from chapter
4.4.1 and 4.4.2, which means you do not need to worry about the relative number of scans or
exposure time of your offset/dark current spectrum and the measurement you want to correct.

7.1.3 Determining the instrument noise and total noise
Instrument noise

1. Take 2 offset spectra (10,000 exposures) back to back and calculate the difference (Math
→ Spectrum Operations → Subtract Spectrum). Determine the standard deviation (see
Statistics, Deviation).
Take a screenshot of the difference spectrum.
How can the instrument noise of a single spectrum now be calculated?

2. Determine the noise for smaller exposure numbers.
Use at least 5 sets of 2 spectra that were recorded under identical conditions, and do the

1 The commands ’Correct Offset’ and ’Correct Dark Current’ automatically correct for different ex-
posure times and number of exposures, so you do not need to do this by hand. However, it is important that
the Properties NumScans and ExposureTime of the offset and dark current spectra are correct when these are
saved.
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Figure 7.1: Instrument setup for recording halogen lamp spectra.

above calculation.
How should the instrument noise depend on the number of exposures? Plot the instrument
noise against the number of exposures.

Total noise

1. Connect the fibre to the small optical bench for measuring light from the halogen lamp.
Maximize the light throughput into the fibre by adjusting the lenses on the bench until
you reach a saturation of about 60% for a small exposure time (< 100 ms).

What is the optimal setup of the optical components? Hint: The light should be par-
allel between the two lenses.

2. Like with the offset spectra, record 5 sets of 2 halogen lamp spectra each to determine
how the total noise depends on the number of exposures. Save all ten spectra.
Correct both spectra for offset and dark current (Math → Correct Offset . . ., and Correct
Dark Current . . .).

3. Take the difference of the two spectra of each set. Determine the standard deviation. This
gives you the absolute total noise. If the lamp intensity drifted between the two evaluated
measurements, systematic structures (typically of the shape of the lamp spectrum) will
appear in your noise spectrum. In this case, a high pass filter has to be applied: For this
purpose create a copy of the noise spectrum (Edit → Duplicate) and apply a low pass
filter (Math → Filter → Low Pass Binomial, 1000 iterations). Subtract this low pass
filtered spectrum from your original noise spectrum. Now, most systematic structures
should be gone.

If you see systematic structures in the spectrum that can not be explained by noise,
consider adjusting the Math Marker to investigate only a certain range. What are the
implications of doing this?

Compare the total noise and the instrument noise.

4. Analogous to 3., take the quotient of the two spectra of each set. Then, take the loga-
rithm of the quotient. This will give you the optical density of the relative total noise.
Equivalent to the previous analysis, you may perform a high pass filter if you see system-
atic structures. Expressing the total noise in this form is useful in the context of DOAS,
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Figure 7.2: The Script tab. Press the button Browse to open a script. The Edit button opens
the script in a text editor. Press Start to start the script.

as DOAS works with optical densities.

What do you expect the average value to be? Describe the dependence of the relative
total noise on the saturation level and on the number of exposures. What is the physical
explanation of the dependencies? Discuss the influence of the noise on the quality of
atmospheric measurements.

7.1.4 Calibrating the spectrometer
1. Place the mercury vapour lamp on the optical bench for stability. Record a spectrum of

the lamp at a good level of saturation (do not oversaturate the peaks!).

2. Correct for offset and dark current.
You can use a script to save some time. Click on the script tab (see figure 7.2) and select
the script Offset&DunkelstromKorr.js. Open it in the editor and check the paths in the
script. They should be set to FPDaten: \\FP \\Aktuell \\Korrekturspektren \\Offset.sp2
and FPDaten: \\FP \\Aktuell \\Korrekturspektren \\Dunkelstrom.sp2. Please do not
change the script. Instead, save the offset and dark current spectra you measured over
the old ones at this location. Use the Quick Scripts tab next to the Script tab to link
the script Offset&DunkelstromKorr.js to the hotkey position F2. Whenever you want to
correct offset and dark current, you can now do so by simply pressing F2. This will start
the script.

From now on, all measured spectra must be corrected for offset and dark current! Nonethe-
less, you should also save an uncorrected version of every spectrum right after you take
it.

3. Determine the Full Width at Half Maximum (FWHM) of the 4 largest mercury peaks by
hand. The FWHM gives the optical resolution of the spectrometer.
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What is the optical resolution of the spectrometer? Is it constant for all wavelengths?

4. Determine the wavelength calibration.
Zoom in to a mercury peak and place the marker on the center of it (View → Markers →
show Marker). You may also derive the center with a gauss fit on the line. The Properties
window now gives you the channel number of the marker. Use figure 7.3 and the Data
Calibration Assistant (Data → Calibration Assistant) to perform the calibration. Use a
2nd order polynomial. Why shouldn’t you use the peak at 313nm for the calibration?
When the calibration assistant finally asks, where the calibration polynomialshould be
applied, set ticks at all the available options. Write down the polynomial coefficients as
they appear in the Output window. From now on, your calibration will automatically be
applied to all recorded and generated spectra. To still have the opportunity to manually
recalibrate a spectrum, open the script Kalibrieren.js for editing and replace the old cal-
ibration coefficients with your new ones. Save the script and link it to the F3 key. You
can now add the wavelength information to any measured spectrum by pressing F3.
Note: The wavelength information displayed above the spectrum is not always accurate.
To get the accurate wavelength of a certain pixel, double-click in the spectrum to move
the Marker there and then click and hold the Marker. The accurate wavelength will be
displayed at the upper end of the Marker, if you move the Marker around.

Determine the optical resolution of the spectrometer in nanometers.

Figure 7.3: Spectrum of the mercury vapour lamp recorded with the USB2000 spectrometer.

7.2 Laboratory Measurements
In this part of the course, you will prepare a reference cross section of NO2 and measure the
concentration of NO2 in a gas cell. You will learn how to run a DOAS fit.
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7.2.1 Convolution of reference cross sections
The reference cross sections of the trace gases can be measured in the laboratory under con-
trolled conditions, and many research groups are specialized on such experiments.2 However,
because these reference measurements are typically measured at a much higher wavelength
resolution than used in the DOAS measurements, the references must first be adapted to the
resolution of the spectrometer used in this experiment. This is done by convolving the high
resolution reference cross-section with the DOAS instrument slit function. The slit function is
the signal measured by the spectrometer when a monochromatic light source is observed and
is a measure for the optical wavelength resolution of the instrument. The convolution smooths
the reference and removes high resolution structures that the DOAS instrument cannot detect
with its limited resolution.
The literature cross section is in units of [cm2], and represents the absorption of NO2 as a
function of the wavelength. It was recorded at a much higher resolution than our spectrometer
has. In order to use this high resolution cross section in a DOAS evaluation of our spectra, it first
needs to be smoothed to the resolution of our spectrometer. This is done by convolving it with
the instrument point spread function. This function gives the optical resolution: it represents
the spectral line shape of monochromatic light when measured by a particular spectrometer.
In order to conduct this convolution, however, we first need to know the pixel - wavelength
calibration of the spectrometer.
What is the convolution doing mathematically?

1. Zoom in to the single mercury vapour line at 404 nm. Place the green Math Marker (View
→ Markers) over the line. To move the Math Marker, move the mouse to the lower rim
of the spectrum. An arrow will appear, which allows you to move the marker. Moving
the mouse to the sides of the green area will allow you to resize it. Mark the mercury
line so it is completely covered by the green area.

2. Place the Marker in the center of the mercury line, so that the area under the emission
line on both sides of the vertical black marker is the same.

3. Create a new Spectrum Sheet(File→ New...) with 2048 channels. This sheet will contain
the result of the convolution. It needs the spectrometer’s wavelength calibration
(F3)!

4. Open an NO2 literature cross section spectrum.
You will find literature cross sections in the folder Referenzspektren.

5. With NO2 opened in the spectrum sheet, select Math → Convolute.... The Convolution
Kernel is your mercury line. The Target is the new spectrum you just created which has
your wavelength calibration. Don’t use Auto search peak in kernel, but do use Normalize
convolution kernel.

6. At this point, call your experiment adviser to check that all settings are done correctly.
This may save you a lot of time.

7. Run the convolution. Compare the high resolution reference cross section with the con-
voluted cross section. How do they differ?

8. Save the convolved absorption cross section. I recommend a simple name like no2conv,
o3conv, ...

2A comprehensive database of relevant atmospheric species can be found at http://www.
uv-vis-spectral-atlas-mainz.org/
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9. Repeat the above steps to convolute references for ozone, O4 and H2O. You will need
these references for the evaluation of the atmospheric measurements.
What is the effect of the convolution on these references?

7.2.2 Recording a spectrum of the NO2 gas cell
We will now hold a gas cell of length L into the light path between the halogen lamp and the
fiber. The Lambert-Beer equation 4.3 can then be written in a simplified form:

I(λ, L) = I0(λ) · exp(−σNO2(λ) · ρNO2 · L) (7.2)

I(λ) and I0(λ) can be measured directly in this experiment.

1. Record and save a well saturated spectrum of the halogen lamp without any gas cells
between the lamp and the fiber. How many exposures are required? Remember that you
want to evaluate for NO2, so make sure the saturation level of the spectrum is good in
the wavelength range you later want to do the evaluation in. Some parts of the spectrum
may be oversaturated ...

2. Repeat the measurement, but this time place the gas cell between the lamp and the fiber.
Save your spectrum.

Using the 2 spectra you just recorded, you now can calculate the concentration of NO2 in the
gas cell. To do this, you will need the convoluted reference cross section of NO2 you prepared
in the previous section.

7.2.3 Determining the NO2 concentration in the gas cell
By directly applying the Beer - Lambert law of absorption, you can now calculate the NO2

concentration.

1. Correct your measured spectra for offset and dark current.

2. Divide the spectra by each other (Math → Spectrum Operations→ ...).

3. Take the logarithm (Math → Logarithm).

By performing the above steps, you have calculated the optical density τ from equation 4.7:

τ = ln
(
I0(λ)

I(λ)

)
= σNO2(λ) · ρNO2 · L (7.3)

Why is it unproblematic if the saturation or the number of scans of the two spectra is different?

σNO2 is the cross section of NO2, which you have prepared for this spectrometer. In order to
calculate the concentration ρNO2 , we will now perform a least-squares fit. This fit varies the
SCD such that χ2 in the following term is minimized (compare equation 4.8):

χ2 =

[
ln
(
I0(λ)

I(λ)

)
− SNO2 · σNO2(λ)−

∑
k

bkλ
k

]2
(7.4)

This step is done by the fit routine in DOASIS.

47



1. Select a reference cross section which you want to fit to the measured signal.
Click on the Fitting tab on the bottom of the screen (see figure 7.4). Double click on
a line Reference Name column to add a reference. The reference cross section spectrum
must be open in DOASIS.

2. Select an appropriate fit range. To do this, place the red Fit Marker (View → Markers)
over the area of the spectrum that you want to fit. The Fit Marker can be moved and
resized in the same way as the Math Marker.
When selecting a wavelength range for your fit, try to keep the following aspects in mind:

• As a general rule, the width of the fitting range should be < 50 nm.
• How is the saturation of your spectrum? Don’t include areas of the spectrum in

which the saturation is low.
• Where are the largest differential absorption structures of the trace gas you want to

evaluate?
• What other trace gases must be taken into account in this wavelength range? (In

this case, the gas cell only contains NO2, but in the atmosphere there will be several
trace gases which absorb simultaneously.)

To study these aspects, it can be helpful to compare your measurement with the reference
cross section. First, save your measurement. Then, run a high pass filter over it (Math
→ Filter → High Pass Binomial...) to remove broadband structures. Do the same for
the NO2 cross section, and overlay the two spectra on top of each other. You should now
be able to clearly see the NO2 absorption in your gas cell. Find an appropriate fit range,
then use the Undo function to undo the filtering (alternatively you can reload your saved
spectra).
Once you have found an appropriate fit range, you can enter this directly into the Prop-
erties window (Marker → FitHigh, FitLow) or use the red Fit Marker (View → Markers
→ Show Fit Marker) to select a range and then click on Get in the Fitting tab to auto-
matically input the edges of the fit range into the fit scenario.

3. Select a DOAS-polynomial of 3rd to 5th order, in order to account for broad structures
like the intensity variation of the lamp. (You can also add an Offset polynomial to correct
for spectrometer stray light.)

4. Start the fit by clicking on the red exclamation button.

After performing the fit, the fit coefficient for which the minimal χ2 was found is given in the Fit
Coeff. column of the Fitting register. Since the spectra were prepared according to the above
equations, the fit coefficient represents the column density ρNO2 ·L and the unit is molec/cm2.
The Shift value is the amount of pixels the spectrum was shifted to obtain an optimum fit, the
Squeeze value is the factor by which it was squeezed or stretched. These values should be close
to 0 and 1, respectively.
Now take a look at the Fit Residual spectrum and the obtained χ2 value.

What should Fit Residual look like in the case of an ideal fit?

Try varying the fit range. You can save the Fit Result page by using Print and selecting
Microsoft XPS Document Writer as Printer. (Deactivate the Print spectrum information but-
ton, since it takes up too much space on your plot.) This is very useful if you want to show
and compare the quality of your fits in your protocol or report.
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Figure 7.4: The Fitting tab. The references are selected in the column Reference Name. Press
Get to input the current edges of the Fit Marker into the fit settings. The exclamation point
starts the fit. The disk button below it can be used to save the fit settings in a Fit Scenario. Log.
spectrum takes the logarithm of the spectrum before doing the fit. It should be deactivated
here as you already have taken the logarithm!

When you have found the ideal fit range for this NO2 measurement, take two new spectra of
the halogen lamp and the gas cell, but this time optimize the saturation level (to about 80%)
in this wavelength range. Rerun the fit.

Calculate the NO2 concentration and the mixing ratio (amount NO2 molecules per air molecule)
in the gas cell assuming normal pressure and temperature.3
If you leave the lab now, remember to CAREFULLY reattach the fibre coupling to the fibres
of the telescope on the roof. Check if the telescope points to the zenith, close DOASIS and
start the program Dauermessung on the Desktop.

7.3 Atmospheric Measurements
In this section you will use the techniques you have learned to evaluate atmospheric measure-
ment spectra recorded with this experimental setup. The instruments typically run in a zenith
viewing direction, and it will be your task to evaluate the spectra from past measurements.
First, you will evaluate ozone, then NO2. For each species, you will calculate slant column den-
sities as well as vertical columns. The approach will be to first evaluate a single measurement
by means of which you will optimize the fit settings. These settings will then be saved in a Fit
Scenario and will then be used to automatically evaluate the other spectra of that day. The
final product of the evaluations will be a time series of the vertical and slant column densities
for the entire day.

7.3.1 Configuring the fit with a single measurement
1. Pick a day to evaluate. The spectrometer usually runs all the time in zenith observation.

You find the spectra in FPDaten:\FP\Daten\Streulicht. Choose a summer day with
a few hundred spectra and store all spectra in both the FP\aktuell\Streulicht and the
FP\aktuell\Streulichtspektren folders. Delete all spectra previously stored there. Find a
midday (Fraunhofer reference) and evening spectrum from the day you wish to evaluate.
To do this, open the logfile of your date in the FPDaten:\FP\Logfiles folder to find the
Fraunhofer reference. The reference spectrum is the spectrum recorded at the smallest

3Avogadro’s constant = 6.022 · 1023 Mol−1, Molar volume = 22,4 l
Mol
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solar zenith angle. Write down the spectrum number of this spectrum. Also find a
spectrum recorded in the evening at a solar zenith angle close to 80° and write down the
spectrum number. Open these two spectra, correct them for offset and dark current, and
save them in your directory. If no logfile is available, have a look on the recording time
of the spectra - this gives you a good hint on the solar zenith angle (SZA) at the time of
recording. You can see the SZA in the Properties tab in DOASIS under ScanGeometry
and then iterate to the reference spectrum. Note that the time stamp is UTC (consider
this when choosing the starting time for your search).
Why is it advantageous to use a spectrum with a high solar zenith angle to optimize the
settings for your fit?

2. Calculate the Ring Spectrum.
Open the Fraunhofer reference and add your wavelength calibration. Then use the menu
entry Math → Ring Spectrum to calculate a Ring spectrum. Save the obtained spectrum.
It will be used in the fit procedure to correct for the Ring effect.

3. Tip: Go back to the scattered light spectra. Make a copy of the evening spectrum, divide
the Fraunhofer reference by it and calculate the optical density by taking the logarithm.
You should now be able to see the structured absorption lines of ozone in the lower
wavelength range, and probably also of NO2 in the higher wavelength range. This should
give you a good idea of the wavelength ranges where you can do the fit (see item 5 below).
Save your optical density spectrum.

4. For the automated retrieval however, go back to your Fraunhofer reference and take
the logarithm. Save this spectrum. Instead of dividing the Fraunhofer reference by
the evening spectrum, we will now include the logarithm of the reference spectrum as a
reference cross section in the fit. It needs to be input as the first fit reference in the
fit scenario.4

5. Include your Ring spectrum in the fit scenario and link shift and squeeze of the Ring
spectrum to the reference. Then open all convolved trace gas cross sections and include
them in the fit scenario. It is advisable to link the shift and squeeze of all trace gases
together (for example, link the shift and squeeze of NO2 and O4 to O3).

6. Make sure, the ’Log. Spectrum’ option on the right is left open at any time. We take the
logarithm of the measurement spectrum by hand later. Also the evaluation script takes
the logarithm of the measurement spectra automatically.

Why is this helpful to get realistic results?

7. Find appropriate wavelength ranges for ozone and for NO2.

What are the criteria for finding these fit ranges?

Use the overlay function of DOASIS to compare your optical density spectrum to the
4Mathematically, fitting the logarithm of the Fraunhofer reference is the same as dividing by it as can be

shown in the Beer-Lambert law (equation 4.6), except for one small difference: The fit now allows the spectrum
to be slightly shifted against the measurement spectrum. This can be useful if the spectrometer’s wavelength
calibration is not perfectly stable during the course of the day. Strictly speaking, the fit coefficient of the
logarithm of the Fraunhofer reference can be fixed to 1 (or -1, depending on the setup of the fit scenario). The
automated retrieval script monitors the fit coefficient of the first reference spectrum, and gives a warning if it
is not close to 1.
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individual reference cross sections of ozone, NO2, H2O and O4. Try to avoid wavelength
regions in which the H2O absorption is prominent, as removing these structures can be
tricky.

8. Once you have found appropriate fit settings, select the evening spectrum in the spectrum
sheet, take its logarithm and start the fit. Remember to include the reference cross
sections of any species absorbing in your fit range as well as the Ring spectrum. Take
a screenshot of the DOAS fit result overview tab in DOASIS for both the O3 and NO2

fits. Compare your fit scenario with equation 4.8 and identify all terms, including the
polynomials.

9. Review the fit results. Ask yourself the following questions to assess the quality of the
fit:

• What does the fit residual look like?
• Were the traces gases included in the fit identified?
• What is the χ2 value?

10. Play around with the fit settings until you are content that the configuration is correct
and the fit quality is good.

11. Save your final fit settings in a Fit Scenario by clicking on the disk button below the
exclamation point. Use the path FPDaten:\FP\aktuell. The file name must not exceed
eight characters. Check for a very last time, that the ’Log. Spectrum’ option is
left open before saving the fit szenario!

7.3.2 Automated evaluation of an entire day
Now you will evaluate the spectra from the entire day using the settings you found for the
evening spectrum. The script AutomatischeAuswertung.js in the directory
FPDaten:\FP\Daten\Scripts will help you. It uses your offset and dark current spectra to
correct each individual measurement spectrum, then uses your Fit Scenario to subsequently
run the fit for each spectrum. The fit results are stored in a text file.
The ozone evaluation is somewhat easier than the NO2 retrieval. Therefore, it is best to start
with ozone. Also, plot the fit results for ozone and make sure they are reasonable before starting
the NO2 evaluation. Reasonable means that you observe a U-shape.

1. Before you begin the automated retrieval, make sure your offset and dark current spectra
are saved as Offset.sp2 and Dunkelstrom.sp2 in the directory
FPDaten:\FP\aktuell\Korrekturspektren. Also, your Fit Scenario needs to be in the
directory FPDaten:\FP\aktuell and all spectra to be evaluated in both
FPDaten:\FP\aktuell\Streulicht and FPDaten:\FP\aktuell\Streulichtspektren.

2. Start AutomatischeAuswertung.js. The script will ask you for the following input: 5

• First, the script tells you to recheck your offset, dark current and fit scenario files.
As you have already done this click the mouse in the next free line in the output
window and press ENTER.

5WARNING: This script closes all open spectra in DOASIS, so be sure to save your data first. Also, the
input window unfortunately does not accept the BACKSPACE or DEL keys. If you make a typing mistake you
will need to start the script again from the beginning.
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• Now the script asks for the name of your Fit Scenario. Type in the file name, but
do not include the file extension *.fs. Press ENTER.

• Finally, the script asks for a name for the result text file. Choose a name with less
than 8 characters, only include lower case letters and numbers and don’t include a
file extension. Press ENTER.

If all the information was entered correctly, the script now runs the evaluation. The χ2

values are displayed in the output window along with any warnings that may occur.

3. Once the evaluation has finished, you can evaluate your result file stored in
FPDaten:\FP\aktuell. Create the following plots:

• Time series of the differential slant column density (dSCD) for ozone and NO2

• Langley Plot for ozone
• Time series of the vertical column density (VCD) for Ozone in Dobson Units6

What should the time series of ozone dSCDs look like? What about the VCD time series?

What is the main difference between the ozone and NO2 time series, and what causes
this difference?

If you want to do a detailed evaluation at home, you should now quickly check if the output
looks reasonable. One way to do this is by plotting the dSCD time series for both trace gases
using Origin, which is installed on the computer outside the virtual machine. Choose plotting
and select the time as the x-axis, and the fit coeffient as the y-axis. You would expect the time
series to have a U-shape.
If you leave the lab now, remember to CAREFULLY reattach the fibre coupling to the fibres
of the telescope on the roof. Check if the telescope points to the zenith, close DOASIS and
start the program Dauermessung on the Desktop.

7.4 Multi Axis DOAS (MAX-DOAS)
The MAX-DOAS technique is used to gain insight into the vertical distribution of trace gases
in the atmosphere. To this extent, scattered light spectra are recorded using different telescope
elevation angles.

7.4.1 Recording scattered light spectra at different elevation angles
If possible, you should record 4 sets of MAX-DOAS measurements. Each set consists of three
measurements at different telescope elevation angles. These three measurements should be
conducted in rapid succession if possible. Why is this important? Make sure that the telescope
is clean and that there is no water or ice in the tube:

• Measure a spectrum at 7° elevation.

• Measure a spectrum at 12° elevation.

• Measure a zenith spectrum at 90° elevation.
61 DU = 2,6 ·1016molecules

cm2 .
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Use the metal plate mounted on the telescope to adjust to the different elevation angles. Even
though the telescope needs to be readjusted very often, please record the MAX-DOAS mea-
surements in the order mentioned above: 7°, 12°, 90°, 7°, 12°, 90°, 7°, ... Be sure to adjust the
exposure time of the spectrometer to obtain an appropriate saturation level for each individual
spectrum. The individual spectra do NOT need to be recorded at the same exposure time.
Take about 1000 exposures per spectrum. Note the weather conditions during the measure-
ments to be able to better interpret your data later.

7.4.2 MAX-DOAS evaluation
1. Use the respective 90° spectra as your Fraunhofer reference spectrum for each set. Perform

the necessary corrections and calculate a Ring spectrum.

2. Evaluate the individual MAX-DOAS spectra for ozone, NO2, and O4. Write down the
individual fit coefficients of each target gas.

3. Plot your results with Python. How do the dSCDs of the individual species depend on
the telescope elevation angle? How do they depend on the reference?

7.5 Before you leave...
• Adjust the telescope to the zenith position

• Close DOASIS

• Start Dauermessung on the Windows XP Desktop by double-clicking it.

• Remove any files you have added to FPDaten:\FP\aktuell and put them in your own
folder for later reference.
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Chapter 8

Course Report

Be sure to include the following points in your course report:

1. Characterizing the instrumentation

• Offset and dark current (give average values)
• Plot the dark current signal as a function of the exposure time. Is the dark current

stable?
• Plot the instrument noise and the total noise as a function of the number of exposures
• Plot the noise of the optical density as a function of exposures
• Compare the instrument noise to the total noise
• Determine the wavelength calibration and the optical resolution of the spectrometer

2. Gas cell measurements

• NO2 concentration in the gas cell
• NO2 mixing ratio in the gas cell

3. Differential slant column densities for O3 and NO2

• Plot ∆SCD for ozone and NO2 as a function of time of day
• What should these plots look like? Explain why.
• Do these plots match your expectations? Give possible explanations for any discrep-

ancies.

4. Langley Plot for ozone

• Langley Plot: ∆SCD as a function of Air Mass Factor (AMF) for AMF < 5.
• Determine the ozone reference slant column density SCDref in the Fraunhofer ref-

erence by extrapolating the Langley Plot for AMF < 3.5. Also estimate the error of
this value by determining a maximum and minimum possible extrapolation in your
data.

5. Plot the time series of the ozone vertical column density (VCD) over the course of the
day. Include error bars. Compare your VCD to ozone data from satellite measurements.
This data can be found at http://ozoneaq.gsfc.nasa.gov. Heidelberg is at longitude
8.49 and latitude 49.29.
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6. MAX-DOAS

• Plot the ∆SCD as a function of the telescope elevation angle for ozone, NO2 and O4

for each set and compare the measurement sets.
• Which of these trace gases were found in the troposphere, which were only seen in

the stratosphere?
• Can you see the influence of clouds in your O4 measurements?

Please include a critical discussion of your results. Include possible explanations for unexpected
results.
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